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What this exercise is about 

The objective of this lab is to show you how to use SVG diagrams in the monitor visual model. You will 
see how to edit the visual model for the KPI context diagram and the monitoring context diagram. And you will 
use the diagram widget in the business space dashboard to see the results of the visual actions. You will also 
use the instances widget and the click to action capability to see diagrams for specific monitoring contexts. 

Lab requirements 

List of system and software required for the student to complete the lab. 

•	 Rational Application Developer 7.5 or WebSphere Integration Developer 6.2 

•	 WebSphere Business Monitor 6.2 – Toolkit installation including the Monitor development environment 
(Monitor Model editor) and Monitor test environment 

•	 SVG viewer plug-in for your browser – for viewing SVG diagrams in the Diagram view 

o	 Adobe SVG Viewer – http://www.adobe.com/svg 

o	 Renesis SVG Viewer - http://www.examotion.com 

What you should be able to do 

At the end of this lab you should be able to: 

•	 Use Rational Application Developer or WebSphere Integration Developer to add and edit the visual 
model for a monitoring context and a KPI context 

•	 Define a dashboard to view KPI context diagrams and monitoring context diagrams 
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Introduction 

In this lab you will build on the ClipsAndTacks model which is described in another lab document titled 
'WebSphere Business Monitor V6.2 ClipsAndTacks business activity monitoring lab'. You will import the full 
Clips and Tacks model, then update the visual model, deploy the changed model and submit events to the 
monitor model. 

The SVG diagrams have been created for you so you can just import them into the workspace. The SVG 
diagrams were created using WebSphere Business Modeler V6.2. You can create SVG diagrams using other 
tools. Here is a list of some SVG editing tools: http://wiki.svg.org/SVG_Links#Development_tools 

For the monitoring context diagram, you will change the color of tasks in the diagram based on the order 
status. Shipped orders will cause the task 'Ship Order to Customer' to be displayed with a blue color. 
Cancelled orders will cause the task 'Cancel Order and Send Notification' to be displayed with a blue color. 
There is a metric called 'Order_Status' which already contains the status of the order so you will use that 
metric to cause the color changes. 

For the KPI context diagram, you will change the color of tasks in the diagram based on the total number 
of shipped orders. If the total ship count is less than or equal to 2, then the task 'Ship Order to Customer' will 
be displayed with a red color. If the total ship count is greater than 2, then the same task will be displayed with 
a green color. You will also display the total number of orders as a text field underneath the task. There is a 
KPI called 'Ship_Count_KPI' which already contains the total count of shipped orders so you will use that KPI 
as a source for these visual actions. 

Useful URLs 

The following URLs may be helpful to you as you exercise this lab. Note that the port numbers in the URL of 
your installation may be different depending on your configuration. 

• Server administrative console 

https://localhost:9044/ibm/console 

• Business space dashboard 

https://localhost:9444/BusinessSpace 
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Part 1: Import the Clips And Tacks monitor model 

In this section, you will import the Clips And Tacks monitor model into the workspace. If you already have 
the ClipsAndTacks model in your workspace after completing the Clips And Tacks lab, then you may skip 
this section. 

____ 1.	 Start Rational Application Developer or WebSphere Integration Developer and setup the 
environment. 

__ a. Start Rational Application Developer or WebSphere Integration Developer, and when prompted 
point to a new workspace such as c:\workspaces\ClipsAndTacks 

__ b. Close the Welcome tab. 

__ c. Open the Business Monitoring perspective. Select Window > Open Perspective > Business 
Monitoring. 

__ d. If it asks you to Confirm Enablement, then click OK. 

____ 2. Create a new monitoring project. 

__ a. Right click the Project Explorer, then select New > Business Monitoring Project… 

__ b. For Project name, enter ClipsAndTacks 

__ c. Click Finish. You will see the new project in the Project Explorer view. 

____ 3. Import the supplied .mm and .cbe files. 

__ a. Right click ClipsAndTacks in the Project Explorer view, and then select Import… 

__ b. Select General > File system, click Next. 

__ c. Browse to the location containing the files, for example, c:\Labfiles62\ClipsAndTacks 

__ d. Select ActivityEvent.cbe 

__ e. Select ClipsAndTacks.mm 

__ f. Select DeclinedOrderEvent.cbe 

__ g. Select LateAverageOrderShippedEvent.cbe
 

__ h. Select NewOrderEvent.cbe
 

__ i. Click Finish.
 

____ 4.	 Expand the project in the Project Explorer view, then expand the Event Definitions and you will see 
the new events listed. Expand Monitor Models and you will see the new ClipsAndTacks model 
listed. 
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Part 2: Edit the visual model for the monitoring context diagram 

In this section you will use Rational Application Developer or WebSphere Integration Developer to edit the 
visual model for the monitoring context diagram. 

____ 1. Import the supplied SVG diagrams 

__ a. Right click in the Project Explorer view and then select Import… from the pop-up menu 

__ b. Select General ���� File system from the Import dialog and click Next 

__ c. In the following panel, click the Browse button to locate the files, for example, 
<LABFILES62>\VisualModel
 

__ d. Select ClipsAndTacks_KC.svg
 

__ e. Select ClipsAndTacks_MC.svg
 

__ f. Click the Browse button and select ClipsAndTacks for the “Into Folder”
 

__ g. Click Finish.
 

__ h. Expand the project in the Project Explorer view, then expand the SVG Files and you will see the 
new SVG files listed 

____ 2. In the project explorer, navigate to ClipsAndTacks ���� Monitor Models and then double click 
'ClipsAndTacks.mm' to open the editor on the model 

____ 3. Select the Visual Model tab at the bottom of the editor view 

____ 4. The 'Selected Context' defaults to the monitoring context 'ClipsAndTacks MC' 

____ 5. To 'Choose an SVG file' click the 'Browse…' button and navigate to ClipsAndTacks 
����ClipsAndTacks_MC.svg in the SVG Resource Selection dialog 
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____ 6. Click OK 

____ 7. A question dialog pops up asking, 'Create shape sets based on SVG files?' Click Yes 

____ 8. The SVG diagram opens in the visual editor as shown below: 

____ 9.	 Scroll to the right in the diagram and you see the tasks 'Ship Order to Customer' and 'Cancel 
Order and Send Notification' which are the tasks that you will manipulate 

____ 10.	 Set the color of the task 'Ship Order to Customer' to blue if the order is shipped. Use the metric 
Order_Status to determine if the order has been shipped 

__ a. In the bottom left portion of the visual editor view, that is “Add and Edit Shape set Actions” 
section, you see the SVG shapes that are available for use in this file. Find the shape set action 
'Ship_Order_to_Customer' in this list. Right click on this item and then select Add Action ����
Set Color from the pop-up menu 
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__ b. The set color action is added beneath the task in the list. 

__ c. Click in the cell to the right of 'condition'. A button ( ) appears in the expression field. Click on 
the button and then use content assist (Ctrl-space) or type in the following expression in the 
'Expression dialog': Order_Status eq 'Shipped' 

__ d. Click in the cell to the right of 'fill color'. A button ( ) appears. Click the button, select the blue 
color from the color dialog and click OK 

__ e. Press Ctrl-S to save your work 

____ 11. Test the changes using the diagram test facility 

__ a. In the lower right corner of the visual editor view, you see the metrics listed that are referenced in 
the visual model. You can set values for the metrics to see how the model will behave. Enter a 
value for the metric 'Order Status' as follows: 

• Value : Shipped 

__ b. Click the Test button. A diagram preview window is opened. Scroll to the right and you can see 
that the task 'Ship Order to Customer' has been changed to blue color. 
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__ c. Close the diagram preview window 

____ 12.	 Set the color of the task 'Cancel Order and Send Notification' to blue if the order is cancelled. Use 
the metric Order_Status to determine if the order has been cancelled. 

__ a. In the bottom left portion of the visual editor view, that is “Add and Edit Shape set Actions” 
section, you see the SVG shapes that are available for use in this file. Find the shape set 
'Cancel Order and Send Notification' in this list. Right click on this item and then select Add 
Action ���� Set Color from the pop-up menu 

__ b. The set color action is added beneath the task in the list. 

__ c. Click in the cell to the right of condition. A button ( ) appears in the expression field. Click on 
the button and then use content assist (Ctrl-space) or type in the following expression in the 
'Expression dialog': Order_Status eq 'Cancelled' 

__ d. Click in the cell to the right of 'fill color'. A button ( ) appears. Click the button, select the blue 
color from the color dialog and click OK 

__ e. Press Ctrl-S to save your work 

____ 13.	 Test the changes using the diagram test facility 

__ a. In the lower right corner of the visual editor view, you see the metrics listed that are referenced in 
the visual model. You can set values for the metrics to see how the model will behave. Enter a 
value for the metric 'Order Status' as follows: 

• Value : Cancelled 
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__ b. Click the Test button. A diagram preview window is opened. Scroll to the right and you can see 
that the task 'Cancel Order and Send Notification' has been changed to blue color 

__ c. Close the diagram preview window 

____ 14.	 Check for any errors in the Problems view. You should resolve any errors before continuing. 
Warnings and informational messages may be present but these will not be a problem 
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Part 3: Edit the visual model for the KPI context diagram 

In this section you will use Rational Application Developer or WebSphere Integration Developer to edit the 
visual model for the KPI context diagram 

____ 1. If not already open, navigate to ClipsAndTacks ���� Monitor Models and then double click 
'ClipsAndTacks.mm' to open the editor on the model in the project explorer 

____ 2. Select the Visual Model tab at the bottom of the editor view 

____ 3. Select “My KPI Context” for the 'Selected Context' field from the drop down list 

____ 4. To choose and SVG file, click the 'Browse…' button and navigate to ClipsAndTacks 
����ClipsAndTacks_KC.svg in the SVG Resource Selection dialog 

____ 5. Click OK 

____ 6. A question dialog pops up asking, 'Create shape sets based on SVG files?' Click Yes 

____ 7. Now you will see the SVG diagram opened in the visual editor 

____ 8. Set the color of task 'Ship Order to Customer' to green if the total number of shipped orders is 
greater than 2. Use Ship_Count_KPI in the KPI model which contains the total number of 
shipments 

__ a. In the bottom left portion of the visual editor view, that is “Add and Edit Shape set Actions” 
section, you see the SVG shapes that are available for use in this file. Find the shape set 
'Ship_Order_to_Customer_2' in this list. Right click on this item and then select Add Action ����
Set Color from the pop-up menu 

__ b. The set color action is added beneath the task in the list. 

__ c. Click in the cell to the right of condition. A button ( ) appears in the expression field. Click on 
the button and then use content assist (Ctrl-space) or type in the following expression in the 
'Expression dialog': Ship_Count_KPI > 2 

__ d. Click in the cell to the right of 'fill color'. A button ( ) appears. Click the button, select the 
green color from the color dialog and click OK 
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____ 9.	 Set the color of the task 'Ship Order to Customer' to red if the total number of shipped orders is 
less than or equal to 2. Use Ship_Count_KPI in the KPI model which contains the total number of 
shipments 

__ a. In the bottom left portion of the visual editor view, that is “Add and Edit Shape set Actions” 
section, you see the SVG shapes that are available for use in this file. Find the shape set 
'Ship_Order_to_Customer_2' in this list. Right click on this item again and then select Add 
Action ���� Set Color from the pop-up menu 

__ b. The set color action is added beneath the task in the list. 

__ c. Click in the cell to the right of condition. A button ( ) appears in the expression field. Click on 
the button and then use content assist (Ctrl-space) or type in the following expression in the 
'Expression dialog': Ship_Count_KPI <= 2 

__ d. Click in the cell to the right of 'fill color'. A button ( ) appears. Click the button, select the red 
color from the color dialog and click OK 

__ e. Press Ctrl-S to save your work 

____ 10.	 Set the text for the task 'Ship_Order_to_Customer_2_bottom_label' so the 
Ship_Order_to_Customer_2 will show the actual number of shipments. Use Ship_Count_KPI in the 
KPI model which contains the total number of shipments 

__ a. In the bottom left portion of the visual editor view, that is “Add and Edit Shape set Actions” 
section, you see the SVG shapes that are available for use in this file. Find the shape set 
'Ship_Order_to_Customer_2_bottom_label' in this list. Right click on this item again and then 
select Add Action ���� Set Text from the pop-up menu 
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__ b. The set text action is added beneath the task in the list. 

__ c. Click in the cell to the right of 'text value'. A button ( ) appears in the expression field. Click 
on the button and then use content assist (Ctrl-space) or type in the following expression in the 
'Expression dialog': fn:concat('Shipment count: ',Ship_Count_KPI). 

__ d. Press Ctrl-S to save your work 

____ 11. Test the changes using the diagram test facility 

__ a. In the lower right corner of the visual editor view, you see the KPIs listed that are referenced in 
the visual model. You can set values for the KPIs to see how the model will behave. Enter a 
value of 2 for Ship_Count_KPI as follows: 

• Value : 2 

__ b. Click the Test button. A diagram preview window is opened. Scroll to the right and you can see 
that the task 'Ship Order to Customer' has been changed to red color, and the number of 
shipments is shown beneath the task: 

__ c. Close the diagram preview window 

__ d. Now test the green condition. Enter a value of 5 for Ship_Count_KPI in the sample KPI values 
table 

__ e. Click the Test button. A diagram preview window is opened. Scroll to the right and you can see 
that the task 'Ship Order to Customer' has been changed to green color, and the number of 
shipments is shown beneath the task 
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__ f. Close the diagram preview window 

____ 12.	 Check for any errors in the Problems view. You should resolve any errors before continuing. 
Warnings and informational messages may be present but these will not be a problem 
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Part 4: Publish the model to the server 

In this section you will use Rational Application Developer or WebSphere Integration Developer to publish 
the monitor model to the monitor server. 

____ 1. In Project Explorer, expand ClipsAndTacks � Monitor models � ClipsAndTacks.mm. Right click 
over ClipsAndTacks.mm and then select Generate Monitor J2EE Projects from the context menu 

____ 2. If you have already generated the ClipsAndTacks model for another lab, then you may need to 
select 'overwrite existing projects'. Then click Finish. 

____ 3. A progress dialog shows the status of the operation and it closes when the operation is complete. 
Check for errors in the Problems view. There may be warnings, but there should not be any errors. If 
you see errors, then try to perform a clean to see if the errors can be removed: Project > Clean… > 
select 'Clean all projects', then click OK. 

____ 4. Click the Servers tab, then right click and select the Start option to start the server WebSphere 
Business Monitor V6.2. This may take a few minutes to complete. 

____ 5.	 Right click in the servers view, then select 'Add and Remove Projects…'. 

____ 6.	 Click Add to move the ClipsAndTacksApplication from the list of available projects to the list of 
configured projects. Click Finish. Note: If the application is already in the list of configured projects, 
then you may have run another lab and published this application already, so in that case, cancel 
this window and select the 'Publish' option from the server menu. 

____ 7.	 A progress message is displayed in the lower right corner of the window. 

____ 8.	 Check the messages in the console view. You should see the following message when the 
application has been started: 

Application started: ClipsAndTacksApplication 

____ 9.	 In the servers view, right click, then select Run administrative console. You should see it open in 
a separate tab. It will prompt you for user ID and password. Enter 'admin' without the quotation 
marks for user ID, and then enter 'admin' without the quotes for password. 

____ 10.	 Click Log in 

____ 11.	 Click Applications > Monitor Models. The application should show green status if it started 
successfully. 
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____ 12.	 If the model shows red (stopped), then wait a moment, then refresh by clicking on the icon to the 
right of Status in the last column of the table. You should see green (started) for the model. If it does 
not show green, be patient and keep refreshing until it does show green. 

____ 13.	 Check the server log to ensure there are no problems. You can check this in the console view. 

____ 14.	 If you are using the integrated server within WebSphere Integration Developer or Rational 
Application Developer, then you do not need to setup Monitor data security, since the administrative 
user is automatically authorized to all models. If you are using a different server, then you should 
open the administrative console, navigate to Security > Monitor Data Security, then add the 
model, role and user information to a resource group. 
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Part 5: Create a dashboard 

In this section you will build a dashboard in business space. You will add widgets to the dashboard and 
configure them. 

You should install the SVG viewer into your browser, then use that browser in this lab. 

____ 1. Create the dashboard. 

__ a. The default browser is 'Internal Web Browser', but you should not use this one since some 
standard functions are not provided that you may need. Select Window > Preferences > General 
> Web browser > select 'Use external Web browser'. Select an external browser. Click OK. 

__ b. In WebSphere Integration Developer, in the servers view, right click and select Business Space 

__ c. When prompted, enter admin for the user ID and enter admin for the password. You must log in 
with 'admin' so that you can view the alerts which were setup in action manager to be sent to this 
particular user ID. Also, in the toolkit environment, this is the user that is automatically defined on 
the secured server. 

__ d. Click the icon to create a new space. 

__ e. Enter a name such as Dashboard, select Empty, then click OK. 

__ f. Click the icon to create a new page in the Dashboard space. 

__ g. Enter a name such as Page1, select Empty, then click OK. 

__ h. Click Page1 to open it. 
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__ i. Now you can add widgets to the page by clicking on 'Add widgets' in the upper right corner 

, then dragging a widget to the page. If you want to rename the page, change the 
layout or remove the page from display, use the icons to the right of the page name on the tab 

. To return to the business space list, click 'Manage Business Spaces' in the upper 

. 

____ 2. Add the diagrams widget to the dashboard. 

__ a. Click Add widgets, then select Diagrams and drag it to the page. 

__ b. Click Configure on the widget menu. 

right corner 

and 1) To Access the menu, hover the mouse over the right corner of the widget 
then click the down arrow. On this menu you can configure the widget, refresh the widget 
and delete the widget. 

__ c. You can either view the monitoring context or the KPI context of the selected monitoring model. 
Follow the instructions below to configure the Diagrams widget to view the KPI Context of the 
ClipsAndTacks model 

• Select the ClipsAndTacks model 

• Select “Key Performance Indicator context” 

• Select “My KPI Context” 

__ d. Click OK. You should see the diagram displayed in the view. Scroll to the right and you see the 
ship task is marked with red color and the total shipment count is zero. This is correct because 
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you have not processed any events yet, and in the model you specified that the color should be 
red if the shipment count is less than or equal to 2. 

__ e. Do not close the browser, since you will come back here to check results later. Proceed to the 
next section to process some shipments. 
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Part 6: Run events to exercise the model 

Rather than installing a J2EE application to actually create the events that you want to monitor, you are going 
to use a program to simulate the submission of events from the application. 

The supplied program is 'BatchCBEWriter61' and it will submit the events to the Common Event Infrastructure. 
Look for the program in \Labfiles62\ClipsAndTacks\BatchCBEWriter. This program reads XML files which 
represent the Common Base Events for the model. 

____ 1.	 Update BatchCBEWriter61.bat to point WAS_HOME to the monitor server home, for example 'set 
WAS_HOME=C:\IBM\WebSphere\AppServer'. If you are using the integrated monitor server in 
WebSphere Integration Developer, the path would be <WID-Install-Path>\pf\WBMonSrv_wps. If you 
are using the integrated monitor server in Rational Application Developer, the path would be <RAD-
Install-Path>\pf\WBMonSrv. 

____ 2.	 Update config.properties, setting the serverName and portNumber. You can find the port number by 
browsing the server log and finding 'bootstrap port'. For example, check for the log at 
C:\IBM\WebSphere\AppServer\profiles\WBMon01\logs\server1\SystemOut.log . For the integrated 
server in WebSphere Integration Developer, the path would be <WID-Install­
Path>\pf\WBMonSrv_wps\logs\server1\SystemOut.log and the portNumber should be 2810. For the 
integrated server in Rational Application Developer, the path would be <RAD-Install­
Path>\pf\WBMonSrv\logs\server1\SystemOut.log and the portNumber should be 2810. Here is an 
example of the config.properties settings: 

__ a. connect.serverName = localhost 

__ b. connect.portNumber = 2810 

____ 3.	 Open a command window, then change directory to the folder containing BatchCBEWriter61, for 
example, type this command 

__ a. cd \Labfiles62\ClipsAndTacks\BatchCBEWriter 

____ 4.	 Run commands to load the common base events to the server. 

__ a. batchcbewriter61 -Dsource.filename="c:/labfiles62/clipsandtacks/cbe/allevents.xml" 

__ b. When it prompts you for user identity and password, enter 'admin' for both (without the quotation 
marks) 

____ 5.	 When you run BatchCBEWriter61, you should see results such as: 
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Part 7: Check the diagram view for the KPI context 

Now that you have created the events, there should be shipments, so now you can check your 
dashboard to see how this is reflected in the diagram view for the KPI context. 

____ 1.	 Return to the dashboard that you created previously. 

____ 2.	 Take a look at the diagram view in the dashboard. To get the latest results, you may need to refresh 
the widget. Click the down arrow in the upper right corner of the diagrams widget, then select the 
option to refresh. In the diagram, scroll to the right and you see the ship task is marked with green 
color and the total shipment count is 4. This is correct because in the model you specified that the 
color should be green if the shipment count is greater than 2 

____ 3. Do not close the browser, since you will need your dashboard in the next section 
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Part 8: Add the diagram view for monitoring contexts 

In this section you will add the instances view to the dashboard so you can see the monitoring context 
instances. You will also add the diagram view for monitoring contexts. Then you will be able to click a 
monitoring context instance in the instances view and see the diagram for that specific instance. 

____ 1. Return to the dashboard that you created previously 

____ 2. Add the instances widget to the dashboard 

__ a. Click Add widgets, then select Instances and drag it to the page. 

__ b. Click Configure on the widget menu. 

and 1) To Access the menu, hover the mouse over the right corner of the widget 
then click the down arrow. On this menu you can configure the widget, refresh the widget 
and delete the widget. 

__ c. Click the Show/Hide tab, and select monitoring context 'ClipsAndTacks MC'. 

Click button >> to move all the fields to the Selected box. Also, 
click button 'Set as default' which will make this the default monitoring context to display. 

__ d. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.' 

__ e. Then click OK. You should see a list of monitoring context instances for the events that you just 
processed. 
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____ 3. Add another diagram view to the dashboard and configure it to display monitoring contexts 

__ a. Click Add widgets, then select Diagrams and drag it to the page. 

__ b. Click Configure on the widget menu. 

and 1) To Access the menu, hover the mouse over the right corner of the widget 
then click the down arrow. On this menu you can configure the widget, refresh the widget 
and delete the widget. 

__ c. Select the model and monitoring context. 

• Select the ClipsAndTacks model 

• Select “Monitoring context” 

• Select “ClipsAndTacks MC" 

__ b. Click the Cooperative tab, then select 'Enable this widget to interact with other widgets.' 

__ d. Then click OK. You should see the diagram displayed in the view. This is the generic diagram 
without any visual actions displayed. 

____ 4. Click the diagram icon in the instances view to see the diagram for specific instances. 

__ a. In the dashboard, scroll up to the instances view and find one of the monitoring contexts that 
show 'Cancelled' in the order status column. 

__ b. For this item, click the icon in the first column in the diagram column. This will cause the 
monitoring context diagram view to be updated for this specific monitoring context. Since this 
particular order is cancelled, the diagram should show the task 'Cancel Order and Send 
Notification' as blue in color. 

__ c. Click 'Restore Original Context' at bottom of this diagram to return this diagram to the generic 
diagram. 
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__ d. In the dashboard, scroll up to the instances view and then find one of the monitoring contexts 
that show 'Shipped' in the order status column. 

__ e. For this item, click the icon in the first column, the diagram column. This will cause the monitoring 
context diagram view to be updated for this specific monitoring context. Since this particular 
order is shipped, the diagram should show the task 'Ship Order to Customer' as blue in color. 
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What you did in this exercise 

In the lab, you edited the visual model for the monitoring context diagram and the KPI context diagram.
 

Then you published the model to the monitor server.
 

You used the supplied program to simulate the submission of events from the monitored application.
 

You configured dashboards to view KPI context diagrams. You also configured cooperation between the
 
instances widget and monitoring context diagrams.
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